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Related Documentation

The following documents contain information that you might find helpful
as you use this help file:



NI Documents

Note For instructions on printing this help file, click the Search tab
and type print.

NI LabVIEW Modulation Toolkit Readme, installed at Start»All
Programs»National Instruments»Modulation»LabVIEW
Support»Modulation Readme. This file contains important
information about modulation ViIs.

Modulation Toolkit example Vs, installed at Start»All
Programs»National Instruments»Modulation»LabVIEW
Support»Modulation Examples Folder. This folder contains
LabVIEW examples which employ Modulation Toolkit VIs. You
can also browse all installed examples and their descriptions by
opening LabVIEW, pulling down the Help menu, and navigating
to Toolkits and Modules»Modulation.

NI Spectral Measurements Toolkit Readme, installed at Start»All
Programs»National Instruments»Spectral Measurements»Spe
this help file contains important information about modulation and
Spectral Measurements Toolkit VIs.

Spectral Measurements Toolkit User Guide, installed in PDF
format at Start»All
Programs»National Instruments»Spectral Measurements.

NI LabVIEW Spectral Measurements Toolkit Help, installed at
Start»All

Programs»National Instruments»Spectral Measurements»Lak
NI-SCOPE VI Reference Help, contained in the NI High-Speed
Digitizers Help, installed at Start»All Programs»National
Instruments»NI-SCOPE»Documentation.

NI RF Vector Signal Analyzers Help, available at Start»All
Programs»National Instruments»NI-RFSA»Documentation.

NI RF Vector Signal Analyzers Getting Started Guide, printed and
installed in PDF format at Start»All Programs»National
Instruments»NI-RFSA»Documentation.

MAX Remote Systems Help, available in Measurement &
Automation Explorer (MAX) by selecting Help»Help
Topics»Remote Systems.

LabVIEW Real-Time Module User Manual, available at



ni.com/manuals.

You can download PDF versions of the Spectral Measurements Toolkit
User Guide and the NI RF Vector Signal Analyzers Getting Started Guide

at ni.com/manuals (link opens in a new window).

The following resources contain information about concepts related to the
Modulation Toolkit.

@ Note The following resources offer useful background information
about the general concepts discussed in this documentation.
These resources are provided for general informational purposes
only and are not affiliated, sponsored, or endorsed by National
Instruments. The content of these resources is not a
representation of, may not correspond to, and does not imply
current or future functionality in any other National Instruments
product.
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Conventions
This help file uses the following conventions:

<>

[]

»

bold

areen

italic

monospace

Angle brackets that contain numbers separated by an ellipsis
represent a range of values associated with a bit or signal
name—for example, DBIO<3..0>.

Square brackets enclose optional items—for example,
[response].

The » symbol leads you through nested menu items and
dialog box options to a final action. The sequence File»Page
Setup»Options directs you to pull down the File menu,
select the Page Setup item, and select Options from the last
dialog box.

This icon denotes a tip, which alerts you to advisory
information.

This icon denotes a note, which alerts you to important
information.

This icon denotes a caution, which advises you of
precautions to take to avoid injury, data loss, or a system
crash.

Bold text denotes items that you must select or click on in the
software, such as menu items and dialog box options. Bold
text also denotes parameter and cluster names, emphasis, or
an introduction to a key concept.

Underlined text in this color denotes a link to a help topic,
help file, or Web address.

Italic text denotes variables or cross references. This font
also denotes text that is a placeholder for a word or value
that you must supply.

Text in this font denotes text or characters that you should
enter from the keyboard, sections of code, programming
examples, and syntax examples. This font is also used for
the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names,
functions, operations, variables, filenames and extensions,



and code excerpts.



Navigating Help (Windows Only)

To navigate this help file, use the Contents, Index, and Search tabs to
the left of this window or use the following toolbar buttons located above

the tabs:
o Hide—Hides the navigation pane from view.

e Locate—Locates the currently displayed topic in the Contents
tab, allowing you to view related topics.

e Back—Displays the previously viewed topic.

e Forward—Displays the topic you viewed before clicking the
Back button.

e Options—Displays a list of commands and viewing options for
the help file.



Printing Help File Topics (Windows Only)

Complete the following steps to print an entire book from the Contents
tab:
1. Right-click the book.
2. Select Print from the shortcut menu to display the Print Topics
dialog box.
3. Select the Print the selected heading and all subtopics option.
Note Select Print the selected topic if you want to print
the single topic you have selected in the Contents tab.

4. Click the OK button.



Printing PDF Documents

This help file may contain links to PDF documents. To print PDF
documents, click the print button located on the Adobe Acrobat Viewer

toolbar.



Searching Help (Windows Only)

Use the Search tab to the left of this window to locate content in this help
file. If you want to search for words in a certain order, such as "related
documentation,” add quotation marks around the search words as shown
in the example. Searching for terms on the Search tab allows you to
quickly locate specific information and information in topics that are not
included on the Contents tab.



Wildcards

You also can search using asterisk (*) or question mark (?) wildcards.
Use the asterisk wildcard to return topics that contain a certain string. For
example, a search for "prog*" lists topics that contain the words
"program,” "programmatically,” "progress,"” and so on.

Use the question mark wildcard as a substitute for a single character in a

search term. For example, "?ext" lists topics that contain the words
"next," "text," and so on.

Note Wildcard searching will not work on Simplified Chinese,
Traditional Chinese, Japanese, and Korean systems.



Nested Expressions

Use nested expressions to combine searches to further refine a search.
You can use Boolean expressions and wildcards in a nested expression.
For example, "example AND (program OR VI)" lists topics that contain
"example program" or "example VI." You cannot nest expressions more

than five levels.



Boolean Expressions

Click the » button to add Boolean expressions to a search. The following
Boolean operators are available:

e AND (default)—Returns topics that contain both search terms.
You do not need to specify this operator unless you are using
nested expressions.

e OR—Returns topics that contain either the first or second term.

e NOT—Returns topics that contain the first term without the
second term.

e NEAR—Returns topics that contain both terms within eight words
of each other.



Search Options

Use the following checkboxes on the Search tab to customize a search:

e Search previous results—Narrows the results from a search
that returned too many topics. You must remove the checkmark
from this checkbox to search all topics.

e Match similar words—Broadens a search to return topics that
contain words similar to the search terms. For example, a search
for "program” lists topics that include the words "programs,”
"programming,” and so on.

o Search titles only—Searches only in the titles of topics.



Digital Communication System Fundamentals

A typical digital communication system includes a transmitter, a receiver,
and a communication channel. The following figure illustrates the general
components of a digital communication system. The transmitter contains
blocks for source and channel coding, modulation, simulating real-world
signal impairments, and upconversion. The receiver includes blocks for
downconversion, matched filtering, equalization, demodulation, and
channel and source decoding. You can quantify the results using tools for
measurement and visualization.
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Decoding

Data decoding involves removing redundant bits from the sequence and
correcting for any errors that might have happened during transmission.
The signal decoding process is usually more complicated than the
encoding process and can be very computationally intensive. However
efficient decoding schemes have been developed over the years —one
example is the Viterbi decoding algorithm, which is used to decode
convolutionally encoded data.

The following VIs are used in channel decoding:

e MT Hamming Decoder

e MT Golay Decoder

e MT Reed-Solomon Decoder
e MT BCH Decoder

e MT Convolutional Decoder
e MT Despread Symbols

e MT LDPC Decoder



lvdmt.chm::/MT_Hamming_Decoder.html
lvdmt.chm::/MT_Golay_Decoder.html
lvdmt.chm::/MT_Reed_Solomon_Decoder.html
lvdmt.chm::/MT_BCH_Decoder.html
lvdmt.chm::/MT_Convolutional_Decoder.html
lvdmt.chm::/MT_Despread_Symbols.html
lvdmt.chm::/MT_LDPC_Decoder.html

Demodulation

The downconverted signal undergoes a demodulation process. This step
is the opposite of modulation and refers to the process required to extract
the original information signal from the modulated signal.

The process of digital demodulation involves matched filtering, symbol
timing extraction, and symbol synchronization followed by frequency
offset correction. The frequency-offset-corrected signal is decimated
down to symbol-spaced data, which is then mapped back to a recovered
bit stream.

The following VIs are used in analog demodulation:

e MT Demodulate AM

e MT Demodulate FM

e MT Demodulate PM
Digital demodulation returns the time-aligned demodulated waveform, the
demodulated information bit stream, and measurement results obtained
during demodulation. The following Vls are used in digital demodulation:

e MT Demodulate ASK

e MT Demodulate FSK

e MT Demodulate MSK

e MT Demodulate PAM

e MT Demodulate PSK

e MT Demodulate QAM

e MT Demodulate CPM
@ Note Use the following VIs if your application requires only the

demodulated bit stream.

e MT Detect ASK

e MT Detect FSK

e MT Detect MSK

e MT Detect PAM

e MT Detect PSK

e MT Detect QAM

e MT Detect CPM



lvdmt.chm::/MT_Apply_Matched_Filter.html
lvdmt.chm::/MT_Align_to_Ideal_Symbols.html
lvmod.chm::/MT_Demodulate_AM.html
lvmod.chm::/MT_Demodulate_FM.html
lvmod.chm::/MT_Demodulate_PM.html
lvdmt.chm::/MT_Demodulate_ASK.html
lvdmt.chm::/MT_Demodulate_FSK.html
lvdmt.chm::/MT_Demodulate_MSK.html
lvdmt.chm::/MT_Demodulate_PAM.html
lvdmt.chm::/MT_Demodulate_PSK.html
lvdmt.chm::/MT_Demodulate_QAM.html
lvdmt.chm::/MT_Demodulate_CPM.html
lvdmt.chm::/MT_Detect_ASK.html
lvdmt.chm::/MT_Detect_FSK.html
lvdmt.chm::/MT_Detect_MSK.html
lvdmt.chm::/MT_Detect_PAM.html
lvdmt.chm::/MT_Detect_PSK.html
lvdmt.chm::/MT_Detect_QAM.html
lvdmt.chm::/MT_Detect_CPM.html

Downconversion

The first step in the demodulation process is downconversion from a real
passband waveform to a complex I/Q baseband waveform. This process
involves mixing the real-valued passband waveform with a locally

generated carrier tone, followed by lowpass filtering to generate the 1/Q
baseband waveform.

Use the MT Downconvert Passband VI to downconvert waveforms.


lvmod.chm::/MT_Downconvert_Passband.html

Encoding

A data source generates the information signal sent to a particular
receiver. This signal may be either an analog signal, such as speech, or a
digital signal, such as a binary data sequence. The information signal is
typically a baseband signal represented by a voltage level.

The Source Coding block typically involves data compression. For
example, the ATSC standard for digital video broadcast (DVB) specifies
MPEGII encoding for the transmitted image. A-law, Mu-law, JPEG, A-
87.6 are examples of other compression algorithms commonly used in
source coding.

The Channel Coding block typically involves adding redundant bits to the
data stream to increase the receiver's immunity to noise and interference
in the channel. The output of the Channel Coding block is a series of Os
and 1s. Among the most popular error-correcting schemes are block and
convolutional coding.

Note The Modulation Toolkit does not currently support source
coding. You can use LabVIEW VIs and primitives to apply source
coding in your application.

The Modulation Toolkit provides the following VIs for channel coding:

e MT Hamming Encoder

e MT Golay Encoder

e MT Reed Solomon Encoder
e MT BCH Encoder

e MT Convolutional Encoder
e MT Spread Symbols

e MT LDPC Encoder



lvdmt.chm::/MT_Hamming_Encoder.html
lvdmt.chm::/MT_Golay_Encoder.html
lvdmt.chm::/MT_Reed_Solomon_Encoder.html
lvdmt.chm::/MT_BCH_Encoder.html
lvdmt.chm::/MT_Convolutional_Encoder.html
lvdmt.chm::/MT_Spread_Symbols.html
lvdmt.chm::/MT_LDPC_Encoder.html

Direct Sequence Spread Spectrum (DSSS)

Direct sequence spread spectrum (DSSS) is a process by which data is
transmitted using a higher bandwidth signal that is demanded by the data
rate. Using DSSS allows multiple channels to occupy the same
bandwidth, thus mitigating interference from other users at the expense
of bandwidth expansion.

DSSS spreads each bit of signal data at the transmitter into L chips using
a pseudorandom L-chip spreading code called a code word. The length L
of the pseudorandom spreading code is also known as the

bandwidth expansion factor because the chips are transmitted at a rate
equal to L x bit rate of the data. The spreading code appears random to
all receivers except the intended one, which uses the knowledge of the
spreading code to demodulate and recover the transmitted information.
Thus multiple channels can occupy the same portion of the frequency
spectrum by using code words that have little or no correlation with one
another, and little or no autocorrelation for any shift other than zero.

Mathematically, a DSSS signal is described by

. i-1 _
yle)= Y Y apcolt-n7 -mr)
f=—o =0

where

y(T) is the transmitted DSSS signal
g(T) is the pulse-shaping signal of duration T,

{a,} is the n' information bearing symbol

{c.} is the m™" element of the L-long pseudorandom spreading code

(also known as the chip sequence)
T, is the chip period

T=LxT, is the symbol period



Low-Density Parity Check (LDPC) Encoding

Low-density parity check (LDPC) is a linear error-correcting code that
uses a parity check matrix that provides only a few 1s with respect to a
much larger number of 0s. The main advantage of the parity check matrix
is that it provides a performance that is close to the capacity of many
different channels and linear time complex algorithms for decoding.
Furthermore, parity check matrices are suited for implementations that
make heavy use of parallelism.

An LDPC code is a block code that has a parity check matrix H, every
row and column of which is sparse. A Regular Gallager Code is a LDPC
code in which every column of H has some weight, j, and every row has
some weight, k. Regular Gallager codes are constructed at random
subject to these constraints.

For example, if

the number of ones in each column () = 3

the number of ones in each row (k) = 6

the number of columns (n) = 12

the number of rows (m) = 6 (because m = n*j/k)
the rate of (n, j, k) LDPC Code is R= 1- (j/k)

Then
1 1 1 0011 0001 O0
1 11110000001
gy—|00000111011]1
1 00100011101
010110111000
00 1:03 L0011 310

If the number of 1s per column or row is not constant, the code is an
irregular LDPC code. Usually, irregular LDPC codes outperform regular
LDPC codes.

Refer to the following resources for more information about the
algorithms and methods used in LDPC coding:

e Bernhard M. J. Leiner, "LDPC codes - a Brief Tutorial,” April
2005. http://users.tkk.fi/pat/coding/essays/Idpc.pdf

e Shokrollahi, Amin. LDPC Codes: An Introduction. Digital
Fountain, Inc. Fremont: 2004.



http://www.ipm.ac.ir/IPM/homepage/Amin2.pdf

¢ Richardson, Thomas J. and Rudiger L. Urbanke. "Efficient
Encoding of Low-Density Parity-Check Codes." IEEE
Transactions on Information Theory 47(2): 2001.

e The flooding decoding algorithm is according to following
reference : Sun, Jian. "An Introduction to Low Density Parity
Check (LDPC) Codes." WCRL Seminar Series Wireless
Communication Research Laboratory,West Virginia University:
2003.

e The serial decoding algorithm is according to following reference
: Sharon, E. et al. "An Efficient Message Passing Schedule for
LDPC Decoding." 2004 23rd IEEE Convention of Electrical and
Electronics Engineers in Israel 23: 2004.



Equalization

The Modulation Toolkit employs an adaptive feed-forward equalizer,
which implies that the equalizer taps continuously adapts its coefficients
to compensate for the action of the channel filter. The adaptive feed-
forward equalizer uses a feed-forward adaptive least-mean-squared
(LMS) algorithm to adjust the equalizer taps. At the start of the
equalization process, you must supply training bits to train the equalizer.
After training, the equalizer switches to decision-directed feedback mode,
where the equalizer trains itself based on its own decisions.

The following are types of digital feedforward equalization VIs:
e ASK
e PAM

e PSK
e OAM


lvdmt.chm::/MT_Equalize_ASK.html
lvdmt.chm::/MT_Equalize_PAM.html
lvdmt.chm::/MT_Equalize_PSK.html
lvdmt.chm::/MT_Equalize_QAM.html

Filtering

In a digital communication system, digital information can be sent on a
carrier through changes in its fundamental characteristics such as phase,
frequency, and amplitude. In a physical channel, these transitions can be
smoothed, depending on the filters implemented during transmission. In
fact, filters play an important part in a communications channel because
they can eliminate spectral leakage, reduce channel width, and eliminate
adjacent symbol interference known as inter-symbol interference (ISI).

The matched filter is as important as the pulse-shaping filter. Though the
pulse-shaping filter generates signals such that each symbol period does
not overlap, the matched filter is important because it filters out the signal
reflections that occur in the transmission process. Because a direct-path
signal arrives at the receiver before a reflected signal does, it is possible
for the reflected signal to overlap with a subsequent symbol period. The
matched filter reduces this affect by attenuating the beginning and ending
of each symbol period. Thus, it can reduce ISI.

The Modulation Toolkit provides the following types of filters:

e Raised cosine
¢ Root-raised cosine
e Gaussian pulse-shaping and matched filters



Filter Delay

Modulation Toolkit uses finite impulse response (FIR) filters for different
operations like pulse-shaping, matched, and downconversion filtering.
For such filters, the output signal is related to the input signal as shown
by the following equation:

y[n] = box[n] + byx[n-1] + ... + bpx[n-P]
where P is the filter order

x[n] is the input signal

y[n] is the output signal

b; are the filter coefficients

The initial state for all samples in an FIR filter is 0. The filter output until
the first input sample reaches the middle tap (the first causal sample) is
called the transient response, or filter delay. Given an FIR filter which has
N taps, the delay is (N - 1)/2 samples. This relationship is illustrated in
the following figure, where a sine wave is filtered by an FIR filter with

50 taps.
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Using the Reset? Parameter in Iterative
Modulator/Demodulator Operation

In the Modulation Toolkit, digital modulation VIs initially perform mapping
of the input bits onto symbols and subsequently apply a pulse-shaping
filter to these symbols. The digital demodulation VIs perform matched
filtering and buffering on the recovered complex waveform. Some useful
samples are held in these filters.

In an iterative operation where the modulator/demodulator is called
repeatedly inside a loop to operate on blocks of bits/symbols (all of which
are part of the same message), two options are possible:

o reset? is set to TRUE on every iteration—The filters in the
modulator/demodulator are initialized with zeros on every
iteration of the loop, and the returned output data is shortened by
(N - 1)/2 symbols on all iterations.

e reset? is set to TRUE on the first call and to FALSE on
subsequent iterations—The filters in the modulator/demodulator
are initialized with zeros on the first iteration of the loop. On
subsequent iterations of the loop, the VI uses state information
from previous iterations to initialize the filter.

Recovering Samples in Single Shot Operations

In single-shot operations for modulators and demodulators, the filter
delay is truncated before the signal is generated because these samples
are not valid. Some samples at the end of the block do not appear at the
modulator/demodulator output, and hence appear to have been lost.

You can recover these samples by sending extra samples to the
modulator/demodulator. To determine how many extra samples you must
added, use the following guidelines:

e For Modulation Vis—Let L = pulse-shaping filter length, m =
number of samples per symbol, and M = modulation order. The
number of bits to be added to the input bit stream is given by the
following formula:

log , M

e

Noq -1

e For Demodulation Vis—The demodulation VIs use filters during



matched filtering. Let L be the length of the matched filter. The
number of samples to be added to the input signal prior to
filtering is given by the following formula:

_L-1

2

The N extra samples are obtained by repeating the last sample
value of the input signal N times to ensure signal continuity.

Working with Filter Delay in Modulation Toolkit 4.1
Modulation

The modulation Vls in Modulation Toolkit 4.1 contain a new parameter,
flush buffers?, that allows you to flush out samples that have been
delayed in the pulse-shaping filter. When this parameter is set to TRUE,
the VI internally pads the input data to recover any lost data. Set this
parameter to TRUE for single-shot applications and during the last
iteration of a continuous operation application.

Demodulation

Modulation Toolkit 4.1 provides two methods for demodulation:
demodulation VlIs and detector VIs. The demodulation VIs contain the
same behavior as in Modulation Toolkit 4.0, that is, they allow you to
recover the time-aligned demodulated waveform, the demodulated
information bit stream, and measurement results obtained during
demodulation. The detector VIs return only the demodulated bit stream.
These new VIs contain the flush buffers? parameter that pads the
incoming samples and forces out the samples delayed because of the
FIR filters used in the demodulation algorithms.

@ Note Setting flush buffers? to TRUE destroys the internal states
of the algorithms such that you will be unable to perform
continuous processing on the signal during subsequent iterations.
If flush buffers? is set to TRUE, you must set reset? to TRUE on
the subsequent iteration.



Impairments

All transmission media (including wireless, fiber optic, and copper)
introduce some form of distortion to the original signal. Different types of
channel models have been developed to mathematically represent such
real-world distortions. The Modulation Toolkit can generate a modulated
message signal and optionally add noise, impairments, and channel

models.
The Modulation Toolkit can add the following types of impairments:
o AWGN
e MultiTone
e |/Q Impairments
e Phase Noise
e Generate Fading Profile
e Fading Profile



lvdmt.chm::/MT_Add_AWGN.html
lvdmt.chm::/MT_Add_MultiTone.html
lvdmt.chm::/MT_Apply_IQ_Impairments.html
lvdmt.chm::/MT_Add_Phase_Noise.html
lvdmt.chm::/MT_Generate_Fading_Profile.html
lvdmt.chm::/MT_Apply_Fading_Profile.html

DC Offset

DC offset is a complex signal impairment that shifts the locus of ideal
symbol coordinates off-center in the I/Q plane. A DC offset can be added
to the baseband | component, the Q component, or both. The DC offset
can be either positive or negative, with the sign indicating the direction of
the shift. DC offset is expressed as a percentage of full scale, where "full
scale" (fs) is the amplitude of the baseband guadrature modulation (QM)

waveform.
Individual I and Q Offsets

A= 0%, Aq=0% Aj=0%, Aq < 0%

Combined | and Q Offset

My =00, A = 0%



Frequency Selective Fading

You can use frequency-selective fading to model discrete multipath
wireless channels that are dynamic in both space and time. The input-
output relationship for a discrete multipath model is given by the following
equation:

N(t)

y(t) = Z a; () x (t — 7 ()

where y(t) is the received signal
a,(t) is the complex path attenuation, which is modeled as a random
process with a probability distribution that is Rayleigh or Rician for k
=1,, N(t)
N(t) is the number of paths in the multipath channel
(1) is their corresponding delays
tis time
The Rayleigh fading profile can be implemented using Jakes or Gans
models. If the channel model has a line-of-sight path, the envelope of the

dominant path (that is, the first path) is Rician distributed. Rician profiles
also can be implemented using Jakes or Gans models.

If we assume that the number of multipath components and the delay
structure vary slowly compared to the variations in a (t), the previous

relationship can be rewritten as the following equation:

N

y(t) = ) ap(t) x (t — 1)

This type of system is a linear time variant (LTV) system and can be
implemented using a tapped delay line structure as illustrated in the
following figure:
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The selective fading profile instances of the MT Generate Fading Profile
VI generate Rayleigh or Rician distributed fading profiles for the specified
number of paths based on the Jakes or Gans model. The generated
fading profile is a two-dimensional array in which the number of rows is
equal to the number of paths, and the number of columns is equal to the

profile length. The generated profile is passed to the MT Apply Selective
Fading Profile VI.



lvdmt.chm::/MT_Generate_Fading_Profile.html
lvdmt.chm::/MT_Apply_Fading_Profile.html

Phase Noise

Phase noise refers to noise in a carrier signal due to phase and
frequency modulation in the signal. Phase noise is normally very close to
the carrier and is measured in decibels relative to the carrier frequency

(dBc).
Phase noise is expressed as a function of power spectral density and
frequency. In a 1 Hz bandwidth, phase noise is given by

2 = 10log[0.5(S @(f))]P
where S O(f) is the spectral density of phase fluctuations.




Measurement

Communications engineers use different tools to evaluate how well the
transmitted data was received. Bit error rate (BER) and modulation error
ratio (MER) are common metrics for this job.

The following list illustrates the types of measurements that can be
performed with Modulation Toolkit VIs.

o Calculate Bit Error Rate (BER) After Trigger:

- BER

- Accumulated BER

- Trigger Found Index
Digital Demodulation:

- QAM, ASK, PAM, PSK: Frequency Offset, Frequency
Drift, Phase Offset

- ESK: Frequency Offset, Frequency Drift, Deviation Error,
FSK Error

- MSK: Frequency Offset, Frequency Drift
Measure Quadrature Impairments:

- 1/Q Gain Imbalance, Quadrature Skew, Magnitude Error,
EVM, Phase Error, MER

- DC Offsets: I, Q, Origin
Measure Rho (p)
Measure Burst Timing

- Amplitude Droop, Crest Factor
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lvdmt.chm::/MT_Measure_Rho.html
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Amplitude Droop

Amplitude droop, measured in dB, is a measure of the amount that the
signal power falls from the start of a specified measurement window (d,)

to the end of that window (df).

P d;

/ R Amplitude Droop




Bit Error Rate (BER)

Bit error rate (BER) is the ratio of erroneous bits to total bits transmitted,
received, or processed over some stipulated period. Transmission BER
expresses the number of erroneous bits received divided by the total
number of bits transmitted. Information BER expresses the number of
erroneous decoded (corrected) bits divided by the total number of
decoded (corrected) bits.



Deviation Error

For an M-FSK system, the average deviation error is defined as the
average spread magnitude of the FSK demodulated symbol spaced
waveform around the ideal symbol (frequency) locations.
Mathematically, the deviation error is defined as

M-1

1
fdev = Y] E[ﬁ'dea.",i - {factua.",i}]
i=0

where M is the FSK modulation format, f 4.4 ; is the ideal symbol location

at the FSK frequency corresponding to location /, and <f 5.y,4 > iS the
mean value of the demodulated symbols at location i.

FSK Demodulated Symbols | °
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In the preceding figure, the horizontal lines represent the actual FSK
demodulated symbol locations, and the vertical lines represent the ideal
symbol locations for a 4-FSK format.



Error Vector Magnitude (EVM)

Error vector magnitude (EVM) is a measurement of demodulator
performance in the presence of impairments. The soft symbol decisions
obtained after decimating the recovered waveform at the demodulator
output are compared against the ideal symbol locations. The root mean
square (RMS) EVM and phase error are then used in determining the
EVM measurement over a window of N demodulated symbols.

As shown in the following figure, the symbol decision generated by the
demodulator is given by #. However, the ideal symbol location (using the
symbol map) is given by . Therefore, the resulting error vector is the
difference between the actual measured and ideal symbol vectors given
by § =4 — . The error vector 2 for a received symbol is graphically
represented by the following figure:

Q

-, Measured Symbol Location

I'.'lugni1unjef .2
Error

8

Idaal Symbal Location

where

¢ is the ideal symbol vector

# 1S the measured symbol vector
# ¢ is the magnitude error

0 is the phase error

¢ =@ — v IS the error vector

¢li is the EVM

EVM quantifies, but does not necessarily reveal the nature of the
impairment. To remove the dependence on system gain distribution, EVM
is normalized by |v|, which is expressed as a percentage. Analytically,
RMS EVM over a measurement window of N symbols is defined as



1 '; m v 3
J:,;.Z [-5) +(Q;-9;) ]

EVM =

|E|*.'.:Lﬁ|
where

l;is the | component of the j-th symbol received
Q; is the Q component of the j-th symbol received

Iiis the ideal | component of the j-th symbol received

Y is the ideal Q component of the j-th symbol received
EVM is related to the modulation error ratio (MER) and p. EVM and MER
have a one-to-one relationship. EVM measures the vector difference

between the measured and ideal signals, while p measures the
correlation between the two signals.




Frequency Deviation

Frequency deviation quantifies the amount that a frequency differs from
its specified value, as when measuring how much an oscillator frequency
deviates from its nominal frequency.

In frequency modulation, frequency deviation refers to the maximum
absolute difference, during a specified period, between the instantaneous
frequency of the modulated wave and the carrier frequency.




Frequency Error, Quadrature Modulation (QM)

In guadrature-modulated (QM) systems, frequency error refers to the
difference between the specified carrier frequency and the actual
measured carrier frequency.

At baseband frequencies, frequency error in QM systems is a complex
signal impairment that manifests itself as a rotation of the locus of symbol
coordinates about the 1/Q plane. A fixed frequency offset appears to be a
rotation at a constant angular velocity. Frequency error can be either
positive or negative in sign, indicating the direction of the rotation.

Q #]

Fraquency Emar = 0 Hz Fraquency Emar < 0 Hz



Frequency Shift-Keying (FSK) Error

For an M-ary ESK system, the average FSK error is defined as the
average root mean squared (RMS) spread of the FSK demodulated
symbol spaced waveform around the ideal symbol (frequency) locations.

Mathematically, the FSK error is defined as

1

M-1 5
Y] 2J<{ﬁ'dea.",i - factua.",i] >

=0

fde Y

where
M is the FSK modulation format

fidear i 1S the ideal symbol location at the FSK frequency corresponding
to location i

f actual i FEPresents the value of the demodulated symbols at location j

FSK Demodulated Symbols [ ° |

Meaal Symbol Location
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Fragueancy Dewvdation, Hz

In the preceding figure, the points represent the actual FSK demodulated
symbol locations, and the vertical lines represent the ideal symbol
locations for a 4-FSK format.



I/Q Gain Imbalance

I/Q gain imbalance refers to a difference in scaling between the | and Q
components of I/Q data. When expressed in dB, I/Q gain imbalance can
be either positive or negative, with the sign indicating which component
has been impaired.
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Magnitude Error, Frequency Shift-Keying (FSK)

In ESK-modulated systems, magnitude error refers to the difference
between the ideal magnitude of the 1/Q signal and the actual measured
magnitude on a symbol-by-symbol basis. For 2-FSK systems, for
example, the magnitude error €, is defined as the average of the space

and mark magnitude errors as shown in the following equation:

where
ip'.\ f".[{"". __Ir.\_}:l
Mty = E({m;~fn})

for all .



Magnitude Error, Quadrature Modulation (QM)

In guadrature modulated (QM) systems, magnitude error refers to the

difference between the ideal magnitude of the 1/Q signal and the actual
measured magnitude on a symbol-by-symbol basis. Magnitude error in
QM systems causes the locus of symbol coordinates to either move away
from the origin and expand or toward the origin and shrink. Magnitude
error affects both the | and Q components simultaneously and can be
either positive or negative, indicating magnitude gain or attenuation,

respectively.
o
jj 1\Iv;'l
i y
| )

Magnitude Errar > 0 dB

Magnitude Errar < 0 dB



Modulation Error Ratio (MER)

The modulation error ratio (MER) is a measure of the signal-to-noise ratio
(SNR) in a digitally modulated signal. Like SNR, MER is usually
expressed in dB. MER over N number of symbols is defined as

3 rf_,.' +0.)
MER
S I-1) +(0,-0)]

where
l;is the | component of the j-th symbol received
Q; is the Q component of the j-th symbol received
I is the ideal | component of the j-th symbol received
9 is the ideal Q component of the j-th symbol received



Phase Deviation

In phase modulation, phase deviation quantifies the maximum difference
between the instantaneous phase angle of the modulated wave and the
phase angle of the unmodulated carrier wave.




Phase Error

In a guadrature modulated (QM) system, phase error (shown as 0 in the
eqguation below) occurs when the measured phase of the received
symbols deviates from the ideal phase values. If the symbol sequence is
{dy, dy, ds, ..., dy_1}, then the sequence of phase errors is {8, 64, 0, ...,

On.1}- The peak phase error over the N symbols is express as
Opeak = Max(o) i=0,1,2,.. N-1
and the RMS phase error over N symbols is

N
| e 2
' J{ ZH




Quadrature Error

In a guadrature modulated (QM) system, quadrature error, also referred
to as quadrature skew, describes a complex signal impairment such that
the | and Q components are not perfectly orthogonal. Quadrature error
can be either positive or negative, with the sign indicating the orientation
of the error.

Pp=0 @0



Rho (p)

p is a measurement that evaluates modulation quality. It is calculated by
finding the correlation between the recovered waveform and an ideal
waveform that has been reconstructed from the demodulated bits. That
is, the received demodulated waveform is compared to an ideal
waveform obtained by remodulating the output bit stream of the digital
demodulation VI. The p measurement is related to EVM because EVM
measures the vector difference between the measured and ideal signals,
while p measures the correlation between the two signals. The value of p
can range from 0.0 to 1.0. The following table illustrates the ranges for p
and degree of correlation between measured and ideal signals.

p=0.0 uncorrelated
0.0 < p < 1.0|partially correlated
p=1.0 perfectly correlated




Modulation

The modulation block converts the information signal bit stream into in-
phase (I) and guadrature-phase (Q) data components. This block
typically also involves pulse shaping to minimize intersymbol interference
and reduce bandwidth.

Depending on the type of information signal and the particular
transmission medium, different modulation techniques are employed. For
example, in amplitude modulation (AM), the information is represented by
amplitude variations of the carrier signal.

The Modulation Toolkit supports the following types of analog modulation:
AM

EM

PM

The Modulation Toolkit also supports the following types of digital
modulation:

ASK
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Modulation Fundamentals

Expand this book for more information about modulation terminology and
signal analysis fundamentals.



Angle Modulation

Angle modulation varies the angle of a carrier wave according to the
amplitude of the modulating baseband signal (the message signal). The
amplitude of the carrier is kept constant. Phase modulation and
frequency modulation are particular types of angle modulation.

Angle modulation can be expressed using the following equation:

kA
‘;}r = Ar.cnﬂ[le,.f + ﬂﬂin{zﬂ.ﬁu”]

m T

where

A_ is the carrier amplitude

f. is the carrier frequency

k:is the frequency deviation constant in Hz/V
f, is the frequency of the message signal



Baseband

The baseband is the range in the frequency spectrum occupied by the
unmodulated message signal. Both the message signal and the
downconverted complex I/Q signal are referred to as baseband signals.

Refer to the NI Developer Zone at ni.com/zone for more information about
baseband signals.
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Carrier Wave

The carrier wave is a sine wave that is modulated by a message signal
prior to transmission. The message signal modifies the carrier wave
amplitude, frequency, or phase prior to transmission. During modulation,
these characteristics may be varied individually or in combination. The
modified carrier signal, also referred to as the modulated wave, is
transmitted to a receiver.

The message signal data in the received modulated wave is recovered
by removing the carrier signal through demodulation. In advanced
communication systems, the carrier may be a moving signal, also known
as a spread spectrum. When the characteristics of the carrier signal are
deterministic and known by the receiver, virtually any type of carrier
signal can be used.

The nominal frequency of the carrier wave is the carrier frequency. In
frequency modulation, the carrier frequency is the center frequency.




Carson's Rule

Carson's rule defines the approximate modulation bandwidth required for
a carrier signal that is frequency-modulated by a spectrum of frequencies
rather than a single frequency. The Carson bandwidth rule is expressed
by the relation CBR = 2 (Af + f,,), where CBR is the bandwidth
requirement, Af is the carrier peak deviation frequency, and f, is the

highest modulating frequency.




CCDF Measurement

The complementary cumulative distribution function (CCDF) is a
statistical characterization of the time-domain waveform that completely
describes the power characteristics of a signal. A CCDF graph relates
average signal power (X axis) to signal power statistics (Y axis) such that
each point on the CCDF curve shows how much time a signal spends at
or above a given power level. The power level is expressed in dB relative
to the average signal power level.
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Center Frequency

The center frequency is the middle frequency of the channel bandwidth.
In frequency modulation, the center frequency is equal to the rest
frequency—specifically, the frequency of the unmodulated carrier wave.

Center Frequency

S e N KSR




Demodulation

Demodulation describes the recovery, from a modulated wave, of a signal
having the same characteristics as the original message signal.




Freguency

Frequency refers to a basic unit of rate measured in events or oscillations
per second. Frequency also refers to a number representing a specific
point in the electromagnetic spectrum.

The following graph illustrates one period of a sine wave.

NN AN
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Frequency can be represented according to the following equation:

|-

V=i

the period of one oscillation.

"0 =

where T i

Refer to the NI Developer Zone ni.com/zone for more information about
frequency.
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Intermediate Frequency (IF)

The intermediate frequency (IF) is an intermediate signal that is the
product of the RF downconversion process. An RF signal is converted to
an IF signal to be digitized, demodulated, displayed, or processed. For
example, the NI PXI-5600 downconverter module converts RF signals to
IF signals in a band between 5-25 MHz.




1/Q Data

I/Q data is an alternative method of describing the magnitude and phase
data of a signal.

A sinusoidal wave can be written in polar coordinate form as shown in the
following equation:

f(t) = Acos(2ft + @)
where

A is the amplitude

2#f is the frequency

@ is the phase

A sinusoidal wave can also be represented in a complex Cartesian
coordinate system by its real and complex components such that the in-
phase (I) component can be written as

I(t) = Acos(p)cos(2xft)
and the quadrature (Q) component can be written as
Q(t) = Asin(p)sin(2xft)

Graphically, | and Q projections of the polar coordinate sinusoidal wave
are on the x and y axis, respectively, as illustrated in the following graph.

T

In the preceding figure, the sinusoidal wave frequency is shown as the
rotational rate of the vector + around the circle.

The vector magnitude (M) is given by

M = (152 + Q)Y

and the vector phase is given by
@ = tan~1(Q/).



While magnitude and phase data seem more intuitive, hardware design
concerns make | and Q data the better choice for RF waveforms. 1/Q
representation provides an effective way to visualize and measure the
guality of modulation. The following figure is a generic block diagram of
an 1/Q demodulator, which takes an RF signal and separates out the |
and Q component from that incoming RF signal.

The following figure is a generic block diagram of an I/Q demodulator.

|
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The circles with an 'X' represent mixers. The 1/Q modulator is
represented here as part of a downconverter module. The incoming
message signal splits and one signal is multiplied by an in-phase carrier
signal (I) while the other signal is multiplied by a quadrature signal (Q).
This multiplication separates the in-phase and quadrature components
from the incoming signal.




Message Signal/lInformation Signal

The message signal, or information signal, contains the data for
transmission. The message signal is used to modulate the carrier wave
to create the modulated wave for transmission. The message signal data
is recovered from the modulated wave by a process of demodulation.

The message signal is often referred to as the baseband signal.




Modulated Wave

The modulated wave, or modulated signal, refers to the signal for
transmission that consists of the carrier wave modulated by the message
signal. The message signal is recovered by the receiver through a
process of demodulation.

Typically, the incoming wave is an RF signal from a unit under test (UUT).




Modulation

Modulation is a process that alters the characteristics of a carrier wave
according to information in the message signal to generate a modulated
wave that is transmitted. Modulation Toolkit VIs are capable of analyzing
carrier waveforms with amplitude, phase, or frequency modulation.

The unmodulated carrier is represented by the following equation:

v(t) = A.cos(w.t + 6)
The amplitude-modulated carrier signal is represented by the following
equation:

v(t) = (m(t) + A )cos(w,t + 6)
The frequency-modulated carrier signal is represented by the following
equation:

v(t) = A.cos((m(t)+wt)+ 6)
The phase-modulated carrier signal is represented by the following
equation:

v(t) = A.cos(w.t + 8 + m(t))
where m(t) is the time-varying modulation, A, is the amplitude of the
carrier wave, and w, is the frequency of the carrier wave.



Modulation Depth

In amplitude modulation, modulation depth refers to the ratio of the
unmodulated carrier amplitude to the amplitude deviation for which the
modulated carrier wave reaches its minimum value. If this minimum value
is zero, the modulation depth is 100%. The modulation depth ratio is also
referred to as the modulation index.




Modulation Index

The modulation index is the ratio of the frequency deviation of the
modulated signal to the message signal bandwidth. For FSK modulation,
the modulation index h is defined as the ratio of the spacing between
consecutive frequencies in the FSK symbol map, to the symbol rate.
More precisely,

h=2xf,T/(M-1)
where

M is the modulation format
T is the symbol period
f4is the peak frequency deviation

For example, in 4-FSK, the spacing between consecutive frequencies
equals 2f; / 3, hence the modulation index equals (2f;xT) / 3.

For more information about amplitude modulation, refer to modulation
depth.



On-Off Keying (OOK)

On-off keying (OOK) is a modulation scheme that consists of keying a
sinusoidal carrier signal on and off with a unipolar binary signal. OOK is
equivalent to two-level amplitude-shift keying (ASK).

L [ |
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Phase

Phase refers to periodic changes in waveform magnitude relative to a
standard position or instant of starting. For example, the phase of a wave
of period T with its starting point at t, can be defined in radians:

maodulo((t—1,).T)
T

w2

or in degrees:
modulo((t—1,).71)
;r
Any vector can be represented either in polar coordinates by M : s,
where M is the magnitude and o is the phase angle, or in Cartesian
coordinates, specifically, an Argand diagram, as (a + jb), where a is a real
component and b is an imaginary component such that tan o= (b /a),

where o is the phase angle, and the magnitude, M, is (a %+ b ).

Refer to the NI Developer Zone at ni.com/zone for more information about
phase.

x 360
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Phase Angle

Phase angle refers to the angle between a point on a periodic wave and
a reference point. The reference point may be a point on another periodic
wave.

The angular measurement that defines the relationship between the
periodic wave and the reference point is derived from a projection of a
rotating vector onto the real axis of an Argand diagram. The phase angle
of a point on a wave is the value of the point on the abscissa that
corresponds to the point on the wave. The phase angle of a vector may
be written as

M ¢ o, where M is the magnitude of the vector and e is the phase angle
relative to the specified reference.



Phase-Locked Loop (PLL)

A Phase-locked loop (PLL) is an electronic circuit that controls an
oscillator so that the circuit maintains a constant phase angle relative to a
reference signal.

Voltage
F
FrequEncy_._ Phase Detector Lowpass Filter Cantrolled - requency
Reference . Oufput
Oscillator

A

The operation of the above circuit is typical of all PLLs. This circuit is a
feedback control system that controls the frequency and phase of a
voltage-controlled oscillator (VCO). An input signal is applied to a phase
detector and the output of the VCO connects to the other phase detector
input. As shown in the previous diagram, the frequencies of both signals
are the same. The output of the phase detector develops a voltage
proportional to the phase difference between the two input signals. The
lowpass filter receives this signal from the phase detector and determines
the dynamic characteristics of the PLL. This output signal is the filtered
signal that controls the VCO.



Modulation Schemes

Expand this book for more information about supported modulation
schemes.



Amplitude Modulation (AM)

Amplitude modulation (AM) is a process that varies the amplitude of an
RF carrier signal according to the amplitude of the message signal.

The recovery of the message signal is called demodulation. One of the
benefits of amplitude modulation systems is the ease with which the
baseband message signal can be recovered. Amplitude modulation
generates discrete upper and lower sidebands, which are the sum and
difference between frequencies of the message signal and the carrier
signal.

The following figure illustrates the modulation of a carrier signal, figure a,
by a message signal, figure b. The message signal shape is also referred
to as the amplitude envelope. The result is the modulated wave, figure c.
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Figure a shows a carrier signal with amplitude A.. Figure b shows the
baseband message signal. The transmitted signal in Figure ¢ is given by
the following equation:

vit) = Al +m(1)] = cos(2nrf_ 1)

where m(t) is the time-varying modulation.



Refer to the NI Developer Zone at ni.com/zone for more information about
amplitude modulation.
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Amplitude-Shift Keying (ASK)

Amplitude-shift keying (ASK) refers to a type of amplitude modulation that
assigns bit values to discrete amplitude levels. The carrier signal is then
modulated among the members of a set of discrete values to transmit
information.




Continuous Phase Modulation (CPM)

Continuous phase modulation (CPM) is a constant-amplitude modulation
scheme that can be considered to be a generalization of continuous
phase frequency shift-keying (CPFSK) or minimum shift-keying (MSK).
The lack of phase discontinuities reduces high-frequency spectral
content, making CPM a highly spectrally efficient scheme.

A form of CPM that can result in significant coding gains is multi-h phase
coding, where h stands for the modulation index. This scheme may be
viewed as a generalization of CPFSK schemes because different phase
changes result from the transmission of the same symbol in two
contiguous symbol intervals. A mathematical representation of the signal
during the ith interval, iT <t (i + 1)T, is expressed by the following
formula:

|E
x(t, d) = 'Fgcus(mct+ d; w; [t —iT) + ;)

where Egis the symbol energy

T is the symbol duration

w, Is the carrier frequency in radians/second

d and w are the sequences that represent the M-ary information
sequence.

dw(t - IT) and @ are data phase terms that correspond to the phase
associated with the current data symbol and the phase
accumulation due to the previous data symbol such that

T (mh;
d; it =) = d; | (F)gt, - iMat,
=iT

and
@ = Zmikhk
k=o
ﬂ-’hi.
e S
where - is the angular frequency corresponding to the

modulation index used during the ith baud. The different values of h



can be used between symbol intervals in a round robin fashion.

Refer to the following resources for more information about the
algorithms and methods used in CPM:

e Premiji, Al-Nasir and Desmond P. Taylor. "Receiver Structures for
Multi-h Signaling Formats." IEEE Transactions on
Communications 35,4 (1987).

e Oerder, Martin and Heinrich Mayer. "Digital Filter and Square
Timing Recovery." IEEE Transactions on Communications 36, 5
(1988).



Frequency Modulation (FM)

Frequency modulation (FM) is a type of angle modulation in which the
frequency of a sinusoidal carrier wave deviates from a center frequency
by an amount proportional to the instantaneous value of the message
signal. In FM, the center frequency is the carrier frequency.

Frequency modulation can be expressed using the general equation for
angle modulation.

S, = A cos|2mft + L% gin(2
Sp = A,cos 2nf.r + ——sin(2xf, 1)

m "

where

A_ is the carrier amplitude

f. is the carrier frequency

k:is the frequency deviation constant in Hz/V
f., is the frequency of the message signal

Refer to the NI Developer Zone at ni.com/zone for more information about
frequency modulation.
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Frequency-Shift Keying (FSK)

Frequency-shift keying (FSK) refers to a type of frequency modulation
that assigns bit values to discrete frequency levels. In noncoherent forms
of FSK, the instantaneous frequency is shifted between two discrete
values termed the mark and space frequencies. Coherent forms of FSK
exist that have no phase discontinuity in the output signal. FSK
modulation formats generate modulated waveforms that are strictly real-
values, and thus tend not to share common features with quadrature
modulation (QM) schemes.




Minimum Shift-Keying (MSK)

Minimum shift keying (MSK) modulation is a subtype of ESK modulation.
MSK uses a half-cycle sinusoidal pulse, making the phase change linear
and keeping side lobes low to control adjacent-channel interference.



Phase Modulation (PM)

Phase modulation (PM) is a type of angle modulation in which the phase
angle of a carrier wave is made to deviate from its reference value by an
amount proportional to the instantaneous value of the modulating
message signal. The resulting phase-modulated wave is transmitted.

Phase modulation can be expressed using the following general equation
for angle modulation:

S, = A cos|2mft + L% gin(2
Sp = A,cos 2nf.r + ——sin(2xf, 1)

m "

where

A_ is the carrier amplitude

f. is the carrier frequency

k:is the frequency deviation constant in Hz/V
f., is the frequency of the message signal

Refer to the NI Developer Zone at ni.com/zone for more information about
phase modulation.
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Phase-Shift Keying (PSK)

Phase-shift keying (PSK) in a digital transmission refers to a type of
angle modulation in which the phase of the carrier is discretely varied to
represent data being transmitted—either in relation to a reference phase
or to the phase of the immediately preceding signal element.

For example, when encoding bits, the phase shift could be 0° for
encoding a 0 and 180° for encoding a 1, or the phase shift could be -90°
for 0 and +90° for a 1, thus making the representations for 0 and 1 a total
of 180° apart. In PSK systems designed so that the carrier can assume
only two different phase angles, each change of phase carries one bit of
information, that is, the bit rate equals the modulation rate. If the number
of recognizable phase angles is increased to four, then 2 bits of
information can be encoded into each signal element; likewise, eight
phase angles can encode 3 bits in each signal element.



Quadrature Modulation (QM)

Quadrature modulation (QM) refers to any modulation scheme that uses
two carrier waves out of phase by 90° that are modulated by separate
information signals.

The QM formats available in this toolkit are phase-shift-keying (PSK),
quadrature-amplitude modulation (QAM), and minimum-shift keying

(MSK).




Quadrature Modulated (QM) Waveform, Ideal

In a guadrature modulates (QM) system, the QM ideal waveform is the
sum of the | and Q component of a signal as follows:

s(t) = s/t) *50(1)

To obtain the QM waveform, the baseband components are modulated
orthogonally as

st) = f{f}coa{m{r}
solt) = q{r}aiﬂ{m{f}
thus
s(f) = f'{r}cos-'[mfr}—q{r}siﬂ{mf_r}

where i(t) and q(t) are the baseband | and Q waveforms, respectively.



Quadrature Modulated (QM) Waveform, Practical

In a guadrature modulated (QM) system, the QM practical waveform
differs from the QM ideal waveform. A generalized adjusted QM
waveform can be expressed as

s(t) = (oyi(t) + Ap)cos(m 1) + (apyg(t) + ﬂo}ain{m{_f+ @)

where
wleg is the 1/Q gain imbalance

A, is the in-phase DC offset
Ag is the quadrature DC offset

@ is the quadrature error



Quadrature-Amplitude Modulation (QAM)

Quadrature-amplitude modulation (QAM) is a form of quadrature
modulation in which the two carriers are both amplitude-modulated.



Quadrature-Phase Shift-Keying (QPSK)

Quadrature-phase shift keying (QPSK) is a form of phase-shift keying in
which four different phase angles are used. In QPSK, the four angles are
usually separated by 90° spacing.




Upconversion

The baseband modulated signal undergoes analog upconversion to
frequency-translate the signal to the RF frequency at which the signal is

transmitted.
Use the MT Upconvert Baseband VI to upconvert waveforms.



lvmod.chm::/MT_Upconvert_Baseband.html

Visualization

Visualization tools, such as constellation plots and eye diagrams, are
used to visualize communications measurements.

e Modulation Toolkit supports the following types of digital
visualization:
- 3D Eye Diagram
- 2D Eye Diagram
- Constellation Plot
- Trellis Diagram

- XY graph



lvdmt.chm::/MT_Display_3D_Eye_Diagram.html
lvdmt.chm::/MT_Format_Eye_Diagram.html
lvdmt.chm::/MT_Format_Constellation_Graph.html
lvdmt.chm::/MT_Format_Trellis_Diagram.html
lvmod.chm::/MT_IQ_to_XY_Graph.html

Operating System Support

For information about the supported operating system (OS) for the NI
Modulation Toolkit, refer to the Modulation Readme.




Programming Examples

The Modulation Toolkit includes several examples for LabVIEW. These
examples serve as interactive tools, programming models, and building
blocks in your own applications.

With LabVIEW running, select Help»Find Examples to launch the
LabVIEW Example Finder. The Example Finder offers two ways to
access all installed LabVIEW example VIs and their descriptions:

e Click the Browse tab to locate modulation VI examples by task at
Toolkits and Modules»Modulation or by directory structure at
Modulation.

o Click the Search tab to search all installed examples by keyword.
Enter the keyword FM, for instance, to locate a examples
demonstrating FM modulation and demodulation.

For the location of the installed modulation VI example files, refer to the
NI Modulation Toolkit for LabVIEW Readme.




Examples Available Online

Modulation Toolkit VI examples are also available online at the NI
Developer Zone or at ni.com/examples. Refer to the NI Developer Zone at
ni.com/zone for more information about integrating the Modulation Toolkit

with the RF signal analyzer and RF signal generator.



javascript:WWW(WWW_Zone)

Considerations for Using the LabVIEW Real-
Time Module

To develop a Modulation Toolkit for LabVIEW application in the LabVIEW
Real-Time Module, follow the same steps used for developing any
application in the LabVIEW Real-Time Module, with the addition of using
the Modulation Toolkit for LabVIEW Vis.

@ Note

e Applications running Modulation Toolkit in the LabVIEW
Real-Time Module on an RT target may be compromised
and/or slow at 64 MB. Using Modulation Toolkit VIs may
introduce high jitter into the entire system. NI does not
recommend using these VIs in applications with
deterministic requirements.

e The Modulation Toolkit supports the LabVIEW Real-Time
Module 8.5 and later.

e The Modulation Toolkit is supported only on PXI Real-Time
systems.

Related Documentation

e For configuration instructions for remote systems, refer to the
MAX Remote Systems Help in Measurement & Automation
Explorer (MAX) by selecting Help»Help Topics»Remote
Systems in MAX.

¢ For more information about the LabVIEW Real-Time Module,
refer to the LabVIEW Real-Time Module User Manual at
ni.com/manuals.

o For additional troubleshooting and support information, refer to
the LabVIEW Real-Time Support main page at
ni.com/support/labview/real-time.
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javascript:WWW(WWW_RT)
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Prefixes

Symbol |Prefix|Value
n nano |10 -9
M micro {10 -6
m milli |10 -3
Kk kilo |103
M mega (10 6
G giga (109




Numbers/Symbols

nV |[nanovolts |10-9 volts

KUV |microvolts |10-6 volts

HQ |microohms|10-6 ohms

mQ [milliohms |10-3 ohms

MQ |megaohms|106 ohms

NA [nanoamps |10-9 amperes

HA |microamps|10-6 amperes

mMA |milliamps |10-3 amperes




A

amplitude Measured in dB, is a measure of the amount that the signal
droop power falls from the start of a specified measurement
window (d;) to the end of that window (df).

amplitude A process that varies the amplitude of an radio frequency
modulation (RF) carrier signal according to the amplitude of the
(AM) message signal.

amplitude- Refers to a type of amplitude modulation which assigns bit

shift values to discrete amplitude levels. The carrier signal is
keying then modulated among the members of a set of discrete
(ASK) values to transmit information.

analog-to- A hardware component that converts analog voltages to
digital digitized values. An ADC can convert an analog signal to a
converter digital signal representing equivalent information.

(ADC)



B

bit The ratio of erroneous bits to total bits transmitted, received, or

error processed over some stipulated period. Transmission BER

rate  expresses the number of erroneous bits received divided by the

(BER) total number of bits transmitted. Information BER expresses the
number of erroneous decoded (corrected) bits divided by the
total number of decoded (corrected) bits.

burst For burst signals, burst timing refers to the location of the burst,

timing obtained by its correlation against an ideal power curve. In
addition, an upper and lower mask are used for testing whether
the burst signal satisfies mask specifications. The following figure
shows upper mask, lower mask, and ideal power curve.



C

Carson's
Rule

CCDF

Defines the approximate modulation bandwidth required
for a carrier signal that is frequency-modulated by a
spectrum of frequencies rather than a single frequency.
The Carson bandwidth rule is expressed by the relation
CBR = 2(Af + f,,) where CBR is the bandwidth

requirement, Af is the carrier peak deviation frequency,
and f, is the highest modulating frequency.

The complementary cumulative distribution function

measurement (CCDF) is a statistical characterization of the time-

center
frequency

code word

complex
envelope

component

domain waveform that completely describes the power
characteristics of a signal.

The middle frequency of the channel bandwidth. In
frequency modulation, the center frequency is equal to
the rest frequency—specifically, the frequency of the
unmodulated carrier wave.

The generated coded bits/numbers from a channel
coding system.

A complex representation of the baseband modulated
signal.

The real and imaginary parts of a complex number are
referred to as components. Modulation Toolkit VIs can
use complex components to describe signal properties.

For example, you can represent a two-dimensional vector
of length S by its components S = A + iB, where A and B
are the vector x- and y-components. The real part of the
vector corresponds to the x-component (A), while the
imaginary part corresponds to the y-component (B).



D

data word
DC offset

depuncture

deviation error

digital-to-
analog

The incoming message bits to a channel coding system.

A complex signal impairment that shifts the locus of
ideal symbol coordinates off-center in the 1/Q plane. A
DC offset can be added to the baseband | component,
the Q component, or both. The DC offset can be either
positive or negative, with the sign indicating direction of
the shift. DC offset is expressed as a percentage of full
scale, where "full scale” (fs) is the amplitude of the
baseband QM waveform.

The process of inserting erasure values into the input
data stream prior to its input to the decoder. If the input
data is real-valued BPSK modulated data (as in the
case of unquantized symbol decisions from a
demodulator or equalizer), the erasure values equal 0. If
the input data stream consists of quantized integers
coming from an A/D converter (ADC) at the output of a
demodulator, the erasure values correspond to the
integer representation that is half the maximum output
sample value generated by the analog-to-digital
conversion process.

For an M-FSK system, the average deviation error is
defined as the average magnitude of the spread of the
FSK demodulated symbol spaced waveform around the
ideal symbol (frequency) locations.

Mathematically, the deviation error is defined as:

M-1

faey = % zé[ﬁ'dea.",i - {factua.",i}]
I=

where M is the FSK modulation format, fjye,; is the

ideal symbol location at the FSK frequency
corresponding to location /, and <f .44 > is the mean

value of the demodulated symbols at location i.

A hardware component that converts digital values to
analog voltages. Thus a DAC can convert a digital



converter signal to an analog signal representing equivalent

information.
direct A process by which data is transmitted using a higher
sequence bandwidth signal that is demanded by the data rate.
spread Using DSSS allows multiple channels to occupy the
spectrum same bandwidth, mitigating interference from other
(DSSS) users at the expense of bandwidth expansion.

DSSS is accomplished by spreading each bit of signal
data is spread at the transmitter into L chips, using a
pseudorandom L-chip spreading code called a code
word. The length L of the pseudorandom spreading
code is also known as the bandwidth expansion factor
because the chips are transmitted at a rate equal to

L x bit rate of the data. The spreading code appears
random to all receivers except the intended one, which
uses the knowledge of the spreading code to
demodulate and recover the transmitted information.
Thus multiple channels can occupy the same portion of
the frequency spectrum by using code words that have
little or no correlation with one another, and little or no
autocorrelation for any shift other than zero.

Mathematically, a DSSS signal is described by:

. i-1 _
yle)= Y Y apcolt-n7 -mr)
f=—o =0

where

y(t) is the transmitted DSSS signal
g(t) is the pulse-shaping signal of duration T,

{a} is the i" information bearing symbol

{c,} is the k" element of the L-long pseudorandom

spreading code (also known as the chip sequence)
T, is the chip period, and

T=LxT, is the symbol period

downconverter A signal conditioning device that converts a specific
band of high-frequency (RF) signals to more
manageable intermediate frequencies (IF) that can be




digitized.



F

frequency Refers to a basic unit of rate measured in events or
oscillations per second. Frequency also refers to a number
representing a specific point in the electromagnetic spectrum.



information Contains the data for transmission. The information signal is

signal used to modulate the carrier wave to create the modulated
wave for transmission. The information signal data is
recovered from the modulated wave by a process of
demodulation.

The information signal is often referred to as the baseband
signal or message signal.

interleaver A device that ensures the symbols from several different
code words are well separated during transmission over a
single path, so that the symbols from any given code word
are clearly received in time-division sequence. Interleavers
are used in conjunction with error-correcting codes to
counteract the effects of burst errors.



M

message Contains the data for transmission. The message signal is

signal used to modulate the carrier wave to create the modulated
wave for transmission. The message signal data is recovered
from the modulated wave by a process of demodulation.

The message signal is often referred to as the baseband
signal or information signal.

mixer A nonlinear analog circuit that multiplies two signals. Mixers
are typically used to shift signal frequencies. A mixer receives
two sinusoidal input signals at different frequencies and
returns a signal with components at frequencies equal to the
sum and difference of the two original input frequencies.
Nonlinear mixers are used when performing amplitude
modulation of RF carrier signals.




N

noise The ratio of the actual output noise to the noise that would remain

figure if the instrument did not contribute its own thermal noise. In

(NF) heterodyne systems, output noise power includes spurious
contributions from image-frequency transformation. However, the
portion attributable to thermal noise in the input termination
includes only what appears in the output due to the principal
frequency transformation of the system, and it excludes what
appears via the image frequency transformation.



o

offset A variant of phase-shift keying modulation using 4
guadrature  different values of the phase to transmit the signal. This
phase-shift scheme is sometimes referred to as staggered quadrature
keying phase-shift keying (SQPSK).

(OQPSK)



P

phase- An electronic circuit that controls an oscillator so that the
locked circuit maintains a constant phase angle relative to a
loop reference signal.

(PLL)

puncture The process of artificially increasing the code rate of the data
stream, generated from a block or convolutional encoder, by
selectively deleting certain elements in the data stream.



R

radio
frequency
(RF)

RF signal
analyzer
(RFSA)

refers to the radio frequency range of the electromagnetic
spectrum. RF is often used to describe a range of sub-
infrared frequencies from the tens of MHz to several GHz.

refers to a family of PXI and PXI Express (PXle) devices that
include the NI PXI-5660, the NI PXI-5661, and the NI 5663
RF vector signal analyzers.

Device

Device Components
Name

NI PXI- |[NI PXI-5600 RF downconverter module and an
5660 NI PXI-5620 IF digitizer module

NI PXI- |[NI PXI-5600 RF downconverter module and an
5661 NI PXI-5142 IF digitizer module

NI PXle-|NI PXle-5601 RF downconverter module, an
5663 NI PXle-5622 IF digitizer module, and an NI 5652
local oscillator (LO) source

The NI 5660 uses the ni5660 Vis in LabVIEW and the NI-
TUNER and NI-SCOPE instrument drivers in C, C++, and
LabWindows™/CVI™. The NI 5661 and NI 5663 use the NI-
RFSA driver for controlling the RF downconverter module,
the RF digitizer module, and an LO source (NI 5663 only). All
NI RF signal analyzers include the NI Spectral
Measurements Toolkit for performing frequency-domain
analysis, and modulation VIs for performing analog
modulation and demodulation measurements.



sample
rate

signal-to-
noise ratio
(SNR)

signal-to-
quantized-
noise ratio
(SQNR)

spectral
density

symbol
rate

The sample rate is the rate at which a device acquires an
analog signal, expressed in samples per second (S/s). The
sample rate is usually the clock speed of the analog-to-
digital converter (ADC).

The ratio of the desired signal amplitude to the noise signal
amplitude at a given point in time. SNR is expressed as 20
times the logarithm of the amplitude ratio, or 10 times the
logarithm of the power ratio. SNR is usually expressed in dB
and in terms of peak values for impulse noise and root mean
square (RMS) values for random noise. In defining or
specifying the SNR, specify the signal and noise
characterizations, for example, peak-signal-to-peak-noise
ratio to avoid ambiguity.

A measurement of the effect of quantization errors
introduced by analog-to-digital conversion at the analog-to-
digital converter (ADC). Exceeding the SQNR of your
instrument clips the signal.

A measure of total signal power in a specified spectral
bandwidth divided by the bandwidth, expressed in watts per
hertz (W/Hz).

Expresses the number of symbols transmitted per second
(symbols/s). To convert symbol rate into bit rate, which
expresses the number of bits transferred per second,
multiply the symbol rate by the number of bits per symbol
used in the digital modulation scheme of interest. Symbol
rate is also known as baud rate.
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Warranty

The media on which you receive National Instruments software are
warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of
shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice
of such defects during the warranty period. National Instruments does not
warrant that the operation of the software shall be uninterrupted or error
free.

A Return Material Authorization (RMA) number must be obtained from
the factory and clearly marked on the outside of the package before any
equipment will be accepted for warranty work. National Instruments will
pay the shipping costs of returning to the owner parts which are covered
by warranty.

National Instruments believes that the information in this document is
accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist,
National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition.
The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising
out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES
NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY
DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. CUSTOMER'S RIGHT TO RECOVER
DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL
INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF
THE POSSIBILITY THEREOF. This limitation of the liability of National
Instruments will apply regardless of the form of action, whether in
contract or tort, including negligence. Any action against National
Instruments must be brought within one year after the cause of action



accrues. National Instruments shall not be liable for any delay in
performance due to causes beyond its reasonable control. The warranty
provided herein does not cover damages, defects, malfunctions, or
service failures caused by owner's failure to follow the National
Instruments installation, operation, or maintenance instructions; owner's
modification of the product; owner's abuse, misuse, or negligent acts;
and power failure or surges, fire, flood, accident, actions of third parties,
or other events outside reasonable control.



Copyright

Under the copyright laws, this publication may not be reproduced or
transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in
whole or in part, without the prior written consent of National Instruments
Corporation.

National Instruments respects the intellectual property of others, and we
ask our users to do the same. NI software is protected by copyright and
other intellectual property laws. Where NI software may be used to
reproduce software or other materials belonging to others, you may use
NI software only to reproduce materials that you may reproduce in
accordance with the terms of any applicable license or other legal
restriction.



Patents

For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents.txt file on

your CD, or ni.com/patents.



javascript:WWW(WWW_Patents)

Trademarks

National Instruments, NI, ni.com, and LabVIEW are trademarks of
National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks.

FireWire® is the registered trademark of Apple Computer, Inc.

Handle Graphics®, MATLAB®, Real-Time Workshop®, Simulink®,
Stateflow®, and xPC TargetBox® are registered trademarks, and
TargetBox™ and Target Language Compiler™ are trademarks of The
MathWorks, Inc.

Tektronix® and Tek are registered trademarks of Tektronix, Inc.

Other product and company names mentioned herein are trademarks or
trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are
business entities independent from National Instruments and have no
agency, partnership, or joint-venture relationship with National
Instruments.
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WARNING REGARDING USE OF NATIONAL
INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED
WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY
SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL
IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT
SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF
OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY
ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO
FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER
HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM
SOFTWARE FITNESS, FITNESS OF COMPILERS AND
DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION,
INSTALLATION ERRORS, SOFTWARE AND HARDWARE
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF
ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT
FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR
SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON
THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE
FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY
TERMED "SYSTEM FAILURES"). ANY APPLICATION WHERE A
SYSTEM FAILURE WOULD CREATE ARISK OF HARM TO
PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY
INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE
FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR
APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT
STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT
NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND
DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS
AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE
NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH
OTHER PRODUCTS IN A MANNER NOT EVALUATED OR
CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR



APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR
VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS
PRODUCTS ARE INCORPORATED IN ASYSTEM OR APPLICATION,
INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,

PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR
APPLICATION.



Technical Support and Professional Services

Visit the following sections of the award-winning National Instruments
Web site at ni.com for technical support and professional services:

e Support—Technical support resources at ni.com/support include
the following:

- Self-Help Resources—For answers and solutions, visit
ni.com/support for software drivers and updates, a
searchable KnowledgeBase, product manuals, step-by-
step troubleshooting wizards, thousands of example
programs, tutorials, application notes, instrument drivers,
and so on. Registered users also receive access to the NI
Discussion Forums at ni.com/forums. NI Applications
Engineers make sure every question submitted online
receives an answer.

- Standard Service Program Membership—This
program entitles members to direct access to NI
Applications Engineers via phone and email for one-to-
one technical support, as well as exclusive access to on
demand training modules via the Services Resource
Center. NI offers complementary membership for a full
year after purchase, after which you may renew to
continue your benefits.

For information about other technical support options in
your area, Visit ni.com/services or contact your local office
at ni.com/contact.

e Training and Certification—Visit ni.com/training for self-paced
training, eLearning virtual classrooms, interactive CDs, and
Certification program information. You also can register for
instructor-led, hands-on courses at locations around the world.

e System Integration—If you have time constraints, limited in-
house technical resources, or other project challenges, National
Instruments Alliance Partner members can help. To learn more,
call your local NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact
your local office or NI corporate headquarters. You also can visit the
Worldwide Offices section of ni.com/niglobal to access the branch office
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Web sites, which provide up-to-date contact information, support phone
numbers, email addresses, and current events.



Branch Offices

Office Telephone Number
Australia 1800 300 800
Austria 43 662 457990-0
Belgium 32 (0) 2 757 0020
Brazil 55 11 3262 3599
Canada 800 433 3488
China 86 21 5050 9800
Czech Republic 420 224 235 774
Denmark 45 45 76 26 00
Finland 358 (0) 9 725 72511
France 33(0) 15766 24 24
Germany 49 89 7413130
India 91 80 41190000
Israel 972 0 36393737
Italy 39 02 413091
Japan 8135472 2970
Korea 82 02 3451 3400
Lebanon 961 (0) 1 33 28 28
Malaysia 1800 887710
Mexico 01 800 010 0793

Netherlands

31 (0) 348 433 466

New Zealand

0800 553 322

Norway 47 (0) 66 90 76 60
Poland 48 22 3390150
Portugal 351 210 311 210
Russia 7 495 783 6851
Singapore 1800 226 5886
Slovenia 386 34254200




South Africa 27 011 805 8197
Spain 34 91 640 0085
Sweden 46 (0) 8 587 895 00
Switzerland 41 56 2005151
Taiwan 886 02 2377 2222
Thailand 662 278 6777
Turkey 90 212 279 3031
United Kingdom 44 (0) 1635 523545
United States (Corporate)|512 683 0100
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